
Telkom Self-Diagnosis
Fixed voice and Broadband

Welcome to our self-diagnosis guide. 
Your offline interactive assistant for 
Telkom’s fixed voice and Broadband services.
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This tool was built to help you resolve the most common faults encountered 
when engaging with our services, and focuses on those of you that use a 
PC/laptop or fixed telephone to access them.

The guide is extremely simple to use. You’ll see that every page has clickable buttons and 
we have kept the text to a minimum. Here are some of the main clickable buttons to look 
out for:
 

This way, we hope to help you identify and fix the problem easily without speaking to an 
agent or waiting for a technician. Of course, if the procedures in the guide don’t solve the 
problem, we are more than happy to help you via our normal service channels.

Click if still not workingPrevious page Restart Next appropriate section
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Please click on the service you’re having trouble with: 
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Please click on the issue you’re having with your Internet:
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Restart your modem and computer. Wait for 3 minutes.

Restart computer

Unplug and replug the power cable

Restart modem

Try the following steps if you have no connection:
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Check the indicator lights on the modem

In the case of missing lights please 
follow all steps below

Illustrative example
Please refer to your router user guide to 
confirm the meaning of each light
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Make sure you have power flowing into the modem. Change the AC-DC adapter and 
check if it’s properly connected to the modem.

If the cable is connected and the power remains off, the power cable or adapter might be faulty. Use another adapter of the same voltage 
and charging factor, otherwise you could break the router. This should also only be a temporary solution until you get an original adapter.

1
Try the following steps if you have a power issue:
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Hard reset your modem using one of the following methods.2

Hold down the reset button for 
10 seconds

Before attempting this, you must be sure you have your ISP username and password* and know which menu to access to reinsert your 
login details, as this will reset the modem to factory settings and only the default “guest” account will be able to access the Telkom 
website. Do not do this if you are a business connected via a hub or switch.

*ISP username and password is sent via SMS once the service is activated, alternatively you can contact the Call Centre.

Insert a pin into the reset hole for 
10 seconds

Try the following steps if you have a power issue:
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Check your Wi-Fi connection settings.

Make sure your wireless connection 
indicates “Connected”.

If not, your device might have lost the key. 
Right click the connection, select properties, 

and retype your Wi-Fi password.

1
Try the following steps if you have a Wi-Fi or WLAN issue:
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If you were connecting via Wi-Fi, try to connect a LAN cable from the Wi-Fi router directly 
to your computer*.2

Try the following steps if you have a Wi-Fi or WLAN issue:

*This cable solution is not definitive.
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Ensure the wireless feature is enabled.3

If you did not change the login 
details when you initially setup 
the modem, try ‘admin’ for 
both username and password, 
or ‘admin’ for username, and 
‘password’ for password. Refer to 
the user manual to confirm.

Input the following ATM and 
connection-type settings:
•	 VPI = 8   
•	 VCI = 35    
•	 Encapsulation = PPPoE 
•	 Multiplexing Method = 	

LLC Based
•	 Wireless = Enabled

Try the following steps if you have a Wi-Fi or WLAN issue:

Open your brower. Browse to 
10.0.0.2 and log into the router.

Please note that some routers 
might require a different access 
address, such as 
www.routerlogin.net. 
Refer to the user manual to 
confirm the correct address for 
the router.

http://10.0.0.2
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Change the port the cable connects to on the modem – ADSL modems usually have 		
4 ports to choose from.1

1 12 23 34 4

Try the following steps if you have a LAN or ethernet issue:
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Try changing your cables and filters for known working ones.

ADSL

Phone

Faulty Working

2
Try the following steps if you have a LAN or ethernet issue:
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Check if your LAN adapter is working properly.3
Try the following steps if you have a LAN or ethernet issue:

•	 Go to ‘Start’.
•	 Type ‘Device Manager’ in the search bar.
•	 Click on ‘Device Manager’.
•	 Click on ‘Network adapters’.
•	 Check if device is working properly.
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Hard reset your modem using one of the following methods.4
Try the following steps if you have a LAN or ethernet issue:

Hold down the reset button for 
10 seconds

Insert a pin into the reset hole for 
10 seconds

Before attempting this, you must be sure you have your ISP username and password* and know which menu to access to reinsert your 
login details, as this will reset the modem to factory settings and only the default “guest” account will be able to access the Telkom 
website. Do not do this if you are a business connected via a hub or switch.

*ISP username and password is sent via SMS once the service is activated, alternatively you can contact the Call Centre.
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Try the following steps if you have an ADSL issue:

1
Check the cables that connect the modem and the phone to the filter, and the one 
between the filter and the wall socket. Make sure they are clipped in the correct position 
and seated properly.

ADSL

Phone

AD
SL

 p
or

t
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Make sure you have power flowing into the modem. Change the AC-DC adapter and 
check if it’s properly connected to the modem.2

Try the following steps if you have an ADSL issue:

If the cable is connected and the power remains off, the power cable or adapter might be faulty. Use another adapter of the same voltage 
and charging factor, otherwise you could break the router. This should also only be a temporary solution until you get an original adapter.
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Try changing your cables and filters for known working ones.

ADSL

Phone

Faulty Working

3
Try the following steps if you have an ADSL issue:
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If possible, try connecting your modem to a friend’s ADSL line and see if it works, or 
try connecting another ADSL modem to your line.4

Try the following steps if you have an ADSL issue:

Friend’s ADSL line

Your modem
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Check your ISP username and re-enter your password.1
Try the following steps if you have an Internet or PPP issue:

If you did not change 
the login details when 
you initially setup the 
modem, try ‘admin’ 
for both username 
and password, or 
‘admin’ for username, 
and ‘password’ for 
password. Refer to 
the user manual to 
confirm.

Retype your ISP username 
and password.

Input the following ATM 
and connection-type 
settings:
•	 VPI = 8   
•	 VCI = 35    
•	 Encapsulation = PPPoE 
•	 Multiplexing Method 

= LLC Based
•	 Wireless = Enabled

Open your brower. Browse 
to 10.0.0.2 and log into 
the router.

Please note that some 
routers might require 
a different access 
address, such as 
www.routerlogin.net. 
Refer to the user manual 
to confirm the correct 
address for the router.

http://10.0.0.2
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Check that your computer does not have a virus.

Run your antivirus software

Download a free antivirus software from an alternative 
connection and transfer it to your computer

When installing a new antivirus software, you should be sure to 
uninstall any current antivirus software so it does not conflict with 
the new software.

2
Try the following steps if you have an Internet or PPP issue:

If you do not have an 
antivirus software installed

If you have an antivirus 
software installed
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Perform an isolation test by removing/turning off all devices (except the ADSL modem/
router) that could be affecting the ADSL line, such as:

Answering
machines

*Faulty electric fences can cause impulse noise on the ADSL line which may prevent the ASDL line from syncing. Check for any arcing 
(electrical breakdown) from the fence due to faulty/cracked isolators, plants or any foreign objects touching the fence.

House alarms Cordless 
phones

ADSL modems Electric 
fences*

Fluorescent 
lamps

Try these last steps if nothing has worked:
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Listen for a dial tone when you pick up the landline phone.

Try these last steps if nothing has worked:
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Check with your ISP if you have reached your Internet cap, and top up if that is the case. 
If your ISP is Telkom, follow these steps:1

Try the following steps if you have a slow connection:

Browse to 
https://secure.telkomsa.net/
titracker/

Type your Telkom Internet 
username and password and 
select ‘Submit’.

Your Internet usage is 
displayed.

If the bar is red and your 
current In-bundle Data Used 
is 100%, you have reached 
your Internet cap. 
Select ‘TopUp’ from the 
My Tools menu.

•	 Select ‘Telkom Internet DSL’
•	 Select ‘Submit’

•	 Select the quantity 
(in GBs) you want to 
purchase.

•	 Type in the credit card 
payment information.

•	 Ensure “I have read and 
understand the Terms…” 
is selected, and select 
‘Submit’.

https://secure.telkomsa.net/titracker/
https://secure.telkomsa.net/titracker/
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2 Check if the slow connection happens on a single website, or on multiple websites and 
click on the appropriate option.

Try the following steps if you have a slow connection:
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3
This does not indicate a problem with your ISP or network provider, but rather with the 
website itself, so you should not consider this as a fault. However, some points can be 
useful to check:

Try logging onto the 
site again after a 

few hours

Try a different 
browser 

Try logging onto 
the site from a different 

computer

Perform a speed test 
from www.saix.net 

while connected with 
the guest account. 

Username:
guest@telkomadsl

Password: guest

Try the following steps if you have a slow connection:

www.saix.net
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4 Try deleting your temporary Internet files.

Try the following steps if you have a slow connection:

Tools→Internet 
Options→Delete

Press 
‘Ctrl’ + ‘Shift’ + ‘Del’ 
→Select 
“Everything”→ 
Clear Now

Settings→Show 
advanced settings 
→Privacy→Clear 
browsing data

History→
Clear History
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5 Restart your modem and wait for 3 minutes. If possible try connecting through another 
modem.

Restart modem Swap modem

Try the following steps if you have a slow connection:

Make sure the router is in a well-ventilated space.

Unplug and replug the power cable
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6 If your modem is connected through a telephone extension cable (not usually designed 
to carry data), try removing that cable and replacing it with the provided cable.

Try the following steps if you have a slow connection:
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Check that your computer does not have a virus.7
Try the following steps if you have a slow connection:

Run your antivirus software

Download a free antivirus software from an alternative 
connection and transfer it to your computer

When installing a new antivirus software, you should be sure to 
uninstall any current antivirus software so it does not conflict with 
the new software.

If you do not have an 
antivirus software installed

If you have an antivirus 
software installed
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Perform a latency test.8

•	 Go to ‘Start’.
•	 Type ‘cmd’ in the search bar.
•	 Click on ‘cmd.exe’.
•	 Type ‘ping ping.telkomsa.net’.
•	 The average response time should not be above 200ms.

Try the following steps if you have a slow connection:
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Perform a speed test.9

Open your browser Browse to speedtest.net and 
click ‘Begin Test’

Check the results and compare 
them to your profile

Bear in mind that the number of 
connections on the same line will 

affect the final speed.

Try the following steps if you have a slow connection:

http://www.speedtest.net
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10
Check that your PC network settings are still the same. Uninstall any new software 
or firewall. If you are unsure of what has been installed, restore your computer to a 
previous stage when the Internet was working.

Firewall

Uninstall any new 
software or firewall

Restore your computer to
a previous stage

Software

Please note that you may lose any data that was created after 
the selected restoration point date.

Try the following steps if you have a slow connection:
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Restoring your computer to a previous stage

3 

4 

5 

6 

1 
2 

1.	 Click on ‘Start’.
2.	 Select ‘All Programs’.
3.	 Select ‘Accessories’.
4.	 Select ‘System Tools’.
5.	 Select ‘System Restore’.
6.	 Follow the instructions
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1
If you are using a Wi-Fi connection, check if your signal is ‘Very Good’ or ‘Excellent’. 
Move your computer closer to the modem until you have ‘Excellent’ or maximum signal 
strength.

Try the following steps if you have an unstable connection:

Fair signal Excellent signal
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Restart your modem and computer. Wait for 3 minutes.2
Try the following steps if you have an unstable connection:

Restart computer

Unplug and replug the power cable

Restart modem
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3
Try the following steps if you have an unstable connection:

Check the cables that connect the modem and the phone to the filter, and the one 
between the filter and the wall socket. Make sure they are clipped in the correct position 
and seated properly.

ADSL

Phone

AD
SL

 p
or

t
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Try changing your cables and filters for known working ones.4
Try the following steps if you have an unstable connection:

ADSL

Phone

Faulty Working
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5
Try the following steps if you have an unstable connection:

Make sure you have power flowing into the modem. Change the AC-DC adapter and 
check if it’s properly connected to the modem.

If the cable is connected and the power remains off, the power cable or adaptor might be faulty. Use another adaptor of the same voltage 
and charging factor, otherwise you could break the router. This should also only be a temporary solution until you get an original adaptor.
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6
Try the following steps if you have an unstable connection:

Perform an isolation test by removing/turning off all devices (except the ADSL modem/
router) that could be affecting the ADSL line, such as:

Answering
machines

*Faulty electric fences can cause impulse noise on the ADSL line which may prevent the ASDL line from syncing. Check for any arcing 
(electrical breakdown) from the fence due to faulty/cracked isolators, plants or any foreign objects touching the fence.

House alarms Cordless 
phones

ADSL modems Electric 
fences*

Fluorescent 
lamps
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7 Stick to the maximum number of filters (3) on a line. Check if all analogue devices are 
connected via filter. 

ADSL

Phone
x3

Try the following steps if you have an unstable connection:
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Try the following steps if you have problems with your phone:

1 The fault could be in the cabling between the telephone and the wall socket. Try the 
following steps:

Check if the phone cable is properly 
connected and has power, if applicable

Try using another known working cable



Telkom Self-Diagnosis
Fixed voice and Broadband

Try the following steps if you have problems with your phone:

2 Make sure that every phone is placed back onto the hook and that any cordless phones 
have been disconnected from a previous call.

Check that all phones are on 
their hooks

Check that all cordless phones are
disconnected from calls

Make sure the cordless phone is charged.
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Try the following steps if you have problems with your phone:

3 The fault could be in the telephone device itself. Try using another known working 
telephone.

Faulty Working
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Try the following steps if you have problems with your phone:

4
The problem could be interference from other sources. Perform an isolation test by 
removing/turning off all devices (except the ADSL modem/router) that could be affecting 
the ADSL line, such as:

Answering
machines

*Faulty electric fences can cause impulse noise on the ADSL line which may prevent the ASDL line from syncing. Check for any arcing 
(electrical breakdown) from the fence due to faulty/cracked isolators, plants or any foreign objects touching the fence.

House alarms Cordless 
phones

ADSL modems Electric 
fences*

Fluorescent 
lamps
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Try the following steps if you have problems with your phone:

5 If the phone is connected through a filter, try removing it and reconnecting it straight to 
the wall socket.

The intention of this procedure is just to check if the problem lies in the filter. Keep in mind that a phone must 
be connected through a filter so it doesn’t interfere with your ADSL connection.

Fi
lte

r
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Try the following steps if you have problems with your phone:

6 Too many instruments on the same line can cause poor speech/hearing or even prevent 
phones from ringing

Try connecting only one 
phone to the line

Make sure the ring volume on the 
phone is high
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Connection works for e-mails only or for browsing the Internet only

1 Try the following procedures if your connection works for one given functionality, but not 
for another.

Functionality E-mails affected only Browsing affected only
Issue Cannot send e-mails Cannot receive e-mails Cannot send or receive e-mails Cannot navigate the Internet

Description This could be related to SMTP, 
which allows an e-mails client 
to deliver e-mails to a server.

This could be related to POP3, 
which allows an e-mail client to 
download e-mails from a server.

This might be a connection 
configuration for the e-mail 
program.

Software version

Possible resolutions

•	Check with your ISP if you have reached your Internet cap, and top up if that is the case.

•	Go to ‘File’ → Info’ → ‘Account Settings’ → ‘Account Settings’.
•	On the ‘E-mail’ tab, select your e-mail account → ‘Change’ → ‘Properties’.

•	Go to ‘Start’ → ‘Control panel’ 
→ ‘Internet Options’ → 
‘Connections’.

•	Select ‘Never dial a 
connection’.

•	Go to ‘LAN Settings’ and 
unselect all boxes.

•	Go to the ‘Security’ tab and 
click ‘Reset all zones to default 
level’.

•	On the ‘SMTP servers’ field, 
type: smtp.dsl.telkomsa.net 

•	On the ‘POP3 servers’ field, 
type: pop3.telkomsa.net 

•	Go to ‘Connections’ and 
uncheck: “Always connect 
using this ACC”.

•	 Go to → ’More settings’ → ‘Advanced’ → ‘Incoming server’ and type ‘110’.
•	 Go to ‘Outgoing server’ and type ‘25’.

If nothing resolved your issue, please reset your modem (by holding the button down or inserting a pin behind it. If after that the 
problem still persists, phone Telkom technical support at 10210)
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If nothing resolved your issues, 
please call Telkom on 10210 
and our agents will be happy 

to assist you.

Make sure you inform them on 
the steps you followed. 
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